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1.0 Preface

PitPro is designed to translate raw PTAGIS PIT-tag data into usable
capture histories for programs SURPH and ROSTER. PitPro also provides a variety
of reports, including an error report, a travel-time table, and program diagnostics
for further analysis. The logic of the program is updated continuously, based on the
latest PTAGIS site configuration, ensuring accuracy.

To obtain PitPro go to:

http://www.cbr.washington.edu/paramest/pitpro/

You will also find the latest version of this documentation there and a revision
history detailing the differences and upgrades from version to version.

PitPro, version 4, also includes context-specific help. To access this help,
click on the “What’s this?” icon on the program tool bar. Then click on a specific
program element. The “What’s this?” icon is a mouse pointer with a question mark
beside it.
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2.0 Overview

PitPro uses four data files; two are necessary, tagging and interrogation data,
and two are optional, recapture and mortality data.

The tagging data define the release site and date, species, rearing type, and
length for each fish. Using these data, PitPro determines sample size, checks for
errors, and can include a length covariate in the capture history files if requested.

The interrogation data provide the time and location of observations of study
fish which are translated into capture histories. Based on this data, PitPro
determines the “outcome” of a fish at each capture history site: returned-to-river,
sampled, or transported. A capture history for a fish incorporates this information
for each site in a sequential record of passage.

The recapture and mortality data are optional. Mortality data provide the
time and location of any mortalities. Similarly, the recapture data provide the time
and location of recapture. These data are handled in the same way: a fish was
recaptured or dead is flagged as removed, and any subsequent observations (in the
case of the recaptures) will be ignored. See Section 5 for more detail on input data
files.

The main output of PitPro is the capture histories for each fish. The program
provides one capture history for each fish in the tag group, defined by the tagging
data, excluding those removed for errors but including fish for which there were no
detections, assigning a capture history of all zeros (not detected). The output file
format can be selected to be compatible with SURPH, version 1 or 2, or ROSTER.

PitPro can provide several other useful data files: an error file recording the
reason for any removals, a travel time file with the travel time for each fish from
release to each detection site (if release data is provided), a detection date file with
the date and time of detection as Julian date, and also including the release date, if
provided, and a sequence file with detailed information useful in program
diagnostics. The output files are explained further in Section 6.

PitPro allows the user to select configuration details via the tabs in the main
program window. Many of the settings have defaults that apply to most situations.
One setting that should always be set is the Data folder setting in the Input
section of the Files tab (Section 4.2). The program will only be able to “see” data
that is in this folder. Depending on the data set, the default list of sites on the
Sites tab may need to be changed (Section 4.3). In many cases this is sufficient
preparation to select a data set on the Run setup tab (Section 4.1), click the Add
Run button, and run the program. See Chapter 3, “Running PitPro.”
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A successful run with all other settings left as defaults will produce capture
histories compatible with SURPH (version 2), with fields as defined on the Sites
tab. PitPro will assume that all observations are of juvenile fish (see ”Stage Tab,”
Section ??). For more on configuring PitPro, see the configuration discussion in
Chapter 4, “Program Configuration.”
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3.0 Running PitPro

Once the program is configured (see Chapter 4, “Program Configuration”,
the program can be executed by either clicking the gears icon on the program tool
bar, or by selecting File->Run Pit Processor from the program menu
(Figure 3.1). A message window displays program status and any errors encountered
during program execution. A progress bar displays run status and percent complete.

When the program execution is complete, a pop-up message notifies the user.
At this point the results are available for viewing in the Results Manager, which
is automatically popped up, or is always accessible by selecting Output->Results
Manager from the program menu.
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Figure 3.1: Running PitPro.
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4.0 Program Configuration

The main program window is a set of configuration tabs: Run Setup, Files,
Sites, Tag Screening, Stage Settings, and Advanced. By selecting the menus
and inputs on these tabs, the program can be custom tailored to produce a
user-specified analysis.

4.1 Run Setup

The Run Setup tab handles the definition of the runs – specifying the two
required data files, observation and tag files, and, optionally, one or both of the
optional data files, mortality and recapture data (Figure 4.1). Data sets can be run
as individual runs, consecutively, or grouped together to produce a capture histories
file with multiple populations. Multiple populations are not supported by ROSTER
and should only be used when generating SURPH capture histories.

4.1.1 Data

The data input files are selected through a series of menus under the Run
config heading. These menus will only display files that are found in the folder
pointed to by the Data folder setting, defined on the Files tab (Section 4.2). Also,
by default, a file must match the suffix for its respective data type: interrogation
data should end in “.obs”; tagging data, “.tag”; recapture data, “.rcp”; and
mortality data, “.mrt”. You can uncheck the box next to Filter by file type to
load any file in the Data folder into each data menu. By using these menus and
entering a “Population Name,” a data set is defined. The run is added to the
Defined runs table by clicking the Add Run button. The data files selected for a
defined population can be edited within the Defined runs table by right-clicking on
the respective fields in the table and selecting an alternative from the pop-up menu.

4.1.2 Defined Runs

The Defined runs table contains a list of all of the defined data sets that
will be run when the program executes. The data file selections can be changed or
removed by right-clicking on a field and selecting a new file name from the resulting
pop-up menu. A defined run can be removed by selecting the row for the run and
clicking on the Delete Run button.
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Figure 4.1: Run Setup tab.
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4.1.3 Combining Runs

Defined runs can be executed either consecutively, with separate output files,
or grouped into a single run by checking Combine runs into one. When runs are
executed consecutively, a separate capture histories file is generated for each run.
When runs are grouped, a single capture histories file is generated containing all
populations.

When runs are combined into one, the capture histories file will contain all
capture histories for all runs. The prefix for the output files is normally taken from
the Population Name for the run. When grouping runs together, since it is no
longer obvious what to use as an output file prefix, the program uses the prefix
“composite,” unless a specific prefix is provided. An alternate prefix can be
provided by entering a name in the input box labeled “prefix,” located adjacent to
the Combine runs into one check box. The auxiliary output files, error, travel
time, etc., will be in separate files with a file name based on the Population
Name. Note that multiple populations in a single capture histories file is only
supported by SURPH and not by ROSTER at this time.

4.2 Files

The Files tab provides configuration options for both input and output files.
Here is where the data input and output folders can be set. The output of
particular files can be switched on or off here. This is also a tab where the capture
histories format is set.

4.2.1 Input

Data files are searched for in the folder selected in Data folder input box.
The program will search in this folder for files having the recognized data field
suffixes. The recognized suffixes are given in Table 4.1 (“Input Suffixes”).

4.2.2 Output

4.2.2.1 Output Folder

The output folder is where PitPro places results. This is also the folder in
which the results manager searches for output.
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Figure 4.2: Files tab.
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Table 4.1: Input file suffixes.

Input file type Suffix
Tagging .tag
Interrogation .obs
Recapture .rcp
Mortality .mrt

4.2.2.2 Output File Switches

The program results can be customized by selecting which file types to
output. The most important files are the capture history file, the errors file, and the
detection date file. The detection date file is used by the results manager for
calculating travel times. The sequence file is not necessary. It is for internal
diagnostics and can be very large with 4 lines of output for every fish. It is generally
advisable to leave this output file switch unchecked.

4.2.2.3 Capture Histories File

PitPro will produce capture histories that are compatible with either
SURPH (version 1 or 2) or ROSTER.

4.2.2.4 Covariates

Individual covariate data can be included in the SURPH output file formats.
The data is input to PitPro via the tagging input file, see section 5.2. When
including covariate data it is usually desirable to remove fish that are either missing
the covariates or have a zero for the covariate, depending on the type of data.
Either is possible bye checking Remove zero valued covariates or Remove null
valued covariates.

4.3 Sites

The Sites tab is where the fields that appear in the capture histories are
defined.
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Figure 4.3: Sites tab.
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4.3.1 Release Site

The release site is typically assumed to be upriver of the first juvenile site. In
some cases, the fish are released directly into the bypass system of a dam, and
instead of including all fish released into the bypass as the tag group, only the fish
known to have exited the bypass into the river should be included. By checking the
“Site release” check box, the release site is assumed to be the first defined juvenile
site, and any fish not known to be in the river below the dam is removed from the
tag group and ignored.

4.3.2 Juvenile and Adult Sites

Juvenile and adult sites are displayed in their respective menus. By selecting
a site and clicking add, the site is added to the list of capture history sites. The
order of the sites in the capture history is defined by the order in which they appear
in these lists, with juvenile sites preceding adult sites. To sort the sites in
upriver-to-downriver order in the case of juvenile sites, or in downriver-to-upriver
order for the adult sites, click the “Sort” button.

4.3.3 Last Capture History Site

The last capture history site can be set to any one of the juvenile or adult
sites that have been defined in the previous section. If the last site is not the last
currently defined site, this site will be represented by the second-to-last field in the
capture history, while any detections at subsequent defined sites will be pooled into
the final capture history field. For a site to be pooled into the final capture history
field, it must be defined as a selected site, even though it will not be represented
individually in the capture history.

If the last capture history site is set to the last defined site, then there will
be a one-to-one correspondence between the defined sites and the capture history
fields. The final field will not be pooled in this case; it will represent the final
defined site instead.

4.4 Tag Screening

If a tag file contains multiple fish types, the settings on this tab may be used
to select a species, run, and rearing type so that only fish matching the selected fish
type will be included in the run. This allows for the download of a “master” tag file
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Figure 4.4: Tag Screening tab.
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that can be used against multiple interrogation files. Set these settings to “All” to
disregard fish type.

4.5 Adult Settings

When data includes adult detections the Assume all juvenile
observations should be unchecked. The main challenge becomes determining the
migration year. Other issues include how to handle minijacks (fish returning during
the migration year) and how to manage residualizing fish. There is also a setting for
using Steelhead Return Year.

4.5.1 Steelhead Return Year

It is known that some adult steelhead overwinter within the hydrosystem
during their upstream migration. This means that they initiate their upstream
migration in one calendar year, and complete it in the following calendar year. To
accommodate this life history trait, a “steelhead return year” is available as an
alternative to the return defined by the calendar year. In accordance with NMFS,
we define the steelhead return year to run from July 1 through June 30 of the
following calendar year.

Settings: Under the steelhead return year setting, fish are removed if (1) they
are detected on a known juvenile detector outside the migration year, (2) they are
observed during the spring of the year following juvenile outmigration and before
July 1 of that year, or (3) they are detected as a minijack (i.e., before the start of
the adult return year). In general, fish are removed if they are detected (on adult or
juvenile detectors) from January 1 - June 30 of the year following their (juvenile)
migration year.

4.5.2 Stage Determination

When processing mixed stage (juvenile and adult) observations, it is critical
to know the age of the fish in determining whether a detection is a juvenile or an
adult observation. It is insufficient to use detection location in determining stage
because both juveniles and adults may be detected on the same observation
monitors.

There are two methods available for determining the stage of the fish:
migration year and juvenile cutoff date. If a migration year is supplied (but no
juvenile cutoff date), the program will assign all observations during the migration
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Figure 4.5: Stage Settings tab.
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year as juvenile observations, and all observation in subsequent years into the adult
category. The age is determined by the number of winters between migration and
observation years, so that a fish observed in the year following the migration year
will be in an ocean age class 1, etc. In this scenario, there will be no jacks.

The second method is to supply a juvenile cutoff date where all observations
before this date are categorized as juveniles and all observations subsequent to this
date as adults. If the fish is observed after the cutoff date but during the same year
as the cutoff date (assuming this to be migration year), the fish will be categorized
as a jack. PitPro requires the user to identify the treatment of jacks; see
Section 4.5.3.

4.5.3 Minijacks

A minijack is defined, for the purposes of Program ROSTER, as an adult
returning fish during its migration year. Minijacks can be either ignored or included
in ocean age class 1, in which case minijack detections would be labeled with an
“A” (or “a” if the fish was censored), as would the ocean age 1 fish.

4.5.4 Adult Fallback Transformation

Since the capture history is designed to be sequential by location but not by
time, fish that fallback will have an observation history that will need to be
transformed to fit into the capture history framework. For instance, if a fish is
detected at Bonneville Dam and then McNary Dam, falls back past both dams, and
then is detected at Bonneville Dam again but not at McNary, and then finally at
Lower Granite Dam, it is not clear whether the fish should have a capture history of
101 or 111. If “Last route” is checked, the program will produce the first capture
history (101) but if “Any route” is checked, the program will produce the second
output (111). Either is valid, but it is recommended to use the “Last route” method
when producing data files for use with Program ROSTER.

4.5.5 Residualization

The program has two methods for removing residualizing fish from an
analysis. The first is to remove a fish that is observed on a known juvenile detector
in any year after the defined migration year. The second is to define a date in the
spring of the year following the migration year where any observations of fish are
too early for returning adults, and could imply residualizing fish instead. These fish
are removed when the associated option is selected.
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4.6 Transportation

It is possible to tell the program to censor all transported fish at a particular
transportation site. This is sometimes necessary when working with ROSTER in
order to simplify the estimation process. Only sites listed in the Transportation
Sites list will show transported fish in the resulting capture history file.
Transported fish will be flagged as Unknown at any other transportation site.

It is also possible to treat all sampled fish as transported fish in cases where
the assumption is that sampled fish are diverted to the raceway. Check the box next
to Treat sampled fish at the above sites as transported fish. This will only
apply to fish that are in the selected transportation sites list (above).

4.7 Advanced

The Advanced tab contains options that are not usually changed, but can
be under certain circumstances. For instance, if the site configuration is out of date,
or does not include an interrogation site of interest, the sites configuration can be
modified. Or if fish are being recaptured and removed, even though the recapture is
taking place at the point of release, this behavior can be modified. Following is a
more detailed discussion of these settings.

4.7.1 Site Configuration

The internal logic that allows PitPro to determine fish outcome,
interrogation site sorting order, names, etc., can be modified and customized. The
sites configuration is based on the PTAGIS Site Configuration History and is
updated frequently. Nevertheless, there may be circumstances when the user may
wish to modify the site configuration. To change the behavior of the default
configuration, un-check the Use default sites configuration check box and select
an alternate site configuration. See Section 10 for more information on the site
configuration file format.

4.7.2 Outcome Determination

The outcome, or disposition, of a fish is determined in one of two ways:
Removal trumps all or Last detection. When Removal trumps all is checked,
any detection on a monitor that indicates removal, either sampled or transported,
will supersede any subsequent observations. For example, if a fish is observed on a
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Figure 4.6: Transportation tab.
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Figure 4.7: Advanced tab.
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monitor that indicates transportation, even though it was a later observed on a
return-to-river monitor, the fish will be flagged as transported. If Last detection
is checked, only the last observation will be used.

4.7.3 Recapture Data

Typically a recapture fish is censored, and any subsequent observations, or
recapture and mortalities for that matter, will be ignored. This is often not
desirable in the case of a recapture at the point of release, which is typically seen in
the data. To ignore recaptures at the release site, check Ignore recaptures at the
release site. Any subsequent observations will be treated as if recapture at the
release location had never occurred. It is important that this is check when using
last detection data from PTAGIS since one line of data per fish per site is normal.

4.7.4 Miscellaneous

4.7.4.1 Allow Single-Coil Detections

Typically if a fish is observed on only a single coil at an entire observation
site, it is flagged for removal. This option may be changed by checking Allow
single coil detections.

4.7.4.2 Allow Observed Fish Not Found In Tag File

Usually a fish not found in the tag file is removed. Check the Allow
observed fish not found in tag file check box to allow these fish to be included
in the capture histories results.

4.7.4.3 Display Warning Messages

The program generates warning messages that may provide useful
information but are not generally considered errors, so by default these messages are
not displayed. Check this box to display warnings. Currently the two types of
warnings generated are that the program can’t find detector data for a given
interrogation record, or when a fish flagged as transported is subsequently detected
downstream as a juvenile.
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5.0 Input Files

One of the most significant changes in the new version of PitPro involves the
input data, which has been both simplified, in the case of interrogation data, and
augmented, with the addition of release site, release date, and run data to the
tagging data file, the expansion of mortality data to include mortality site and date,
and the new data input type, i.e., recapture data. The release file has been folded
into the tagging data and is no longer used. The previous version of the mortality
data was essentially a tagging mortality file, which in most cases is removed by
PTAGIS before any data is available for download; it has become irrelevant and is
no longer used.

The most important change is the addition the recapture data file format
and the addition of mortality site to the mortality data. PitPro treats a mortality
or recapture in almost the same way: a fish is censored at the point of
recapture/mortality, or at the nearest prior defined capture history site. In other
words, if a juvenile fish is recaptured or removed as a mortality at McNary Dam, or
between McNary and John Day dams, and McNary is defined as a capture history
site, the fish will be flagged as removed at McNary.

The only exception to this rule is for fish recaptured at the point of release.
If the release site and the recapture site are identical, the recapture may be ignored,
as one option, and any subsequent capture history will be unaffected (i.e. processed
normally).

One other issue has been addressed in the latest version of PitPro; when
interrogation data are loaded into Excel and then saved, hexadecimal coil field
strings, such as “01”, are converted into numbers, and when saved, end up as “1”,
with the leading “0” truncated. Previously the program, which used a string
comparison, would not match “01” and “1”. The program now does numeric
comparisons so that “01” and “1” will result in a match.

In general, data downloaded from PTAGIS are ready to use by PitPro.
PitPro will remove quotes, commas, and any header or footer information before
processing the data. In most of the following examples, the data are shown in
comma-separated variable (CSV) format but tab delimeted will work too. Also
following is a detailed look at the input data files. For a short primer on using
PTAGIS to download PitPro data, see Section 11 (“PTAGIS”).
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5.1 Interrogation Input File

The example below shows the proper format for the interrogation data file.
The file consists of 4 columns (or 5 after commas are removed): tag id, observation
site, observation date and time, and observation coil. The allowed date formats are
dd-mmm-yyyy format (e.g., 03-feb-1997) or mm/dd/yy format (e.g., 02/03/97).
Generally, dates provided by PTAGIS should work. Any lines that don’t match
these formats are ignored. Any commas, quotes, and extra white spaces (spaces or
tabs) are also ignored.

-- begin sample --

3D9.1BF0DB31C5 ,MCJ,2000-05-08 09:40:44,92

3D9.1BF0DB31C5 ,MCJ,2000-05-08 09:40:44,91

3D9.1BF0DB31C5 ,MCJ,2000-05-08 09:40:15,A4

3D9.1BF0DB31C5 ,MCJ,2000-05-08 09:40:14,A3

3D9.1BF0DB31C5 ,MCJ,2000-05-08 09:40:14,A2

3D9.1BF0DB31C5 ,MCJ,2000-05-08 09:40:14,A1

3D9.1BF0DB31C5 ,LMJ,2000-05-05 02:45:13,93

3D9.1BF0DB31C5 ,GOJ,2000-05-01 07:05:31,A1

3D9.1BF0DB31C5 ,BVX,2000-05-15 14:38:51,03

3D9.1BF0DB31C5 ,BVX,2000-05-15 14:38:51,02

3D9.1BF0DB31C5 ,BVX,2000-05-15 14:38:50,01

3D9.1BF0DB31C5 ,LMJ,2000-05-05 02:45:13,92

3D9.1BF0DB31C5 ,LMJ,2000-05-05 02:45:13,91

3D9.1BF0DB31C5 ,JDJ,2000-05-12 21:23:23,52

3D9.1BF0DB31C5 ,GOJ,2000-05-01 07:05:42,C3

3D9.1BF0DB31C5 ,GOJ,2000-05-01 07:05:42,C2

3D9.1BF0DB31C5 ,GOJ,2000-05-01 07:05:31,A2

3D9.1BF0DB31C5 ,GOJ,2000-05-01 07:05:42,C1

3D9.1BF0DB31C5 ,GOJ,2000-05-01 07:05:32,A3

3D9.1BF0DB31C5 ,JDJ,2000-05-12 21:23:23,51

-- end sample --

5.2 Tag File

The tag data file provides PitPro with tagging data, i.e., tag file id, release
information, fish type, and fish length. The sample below shows the proper format
for a tag file. The minimum required columns are: tag id, release date and time,
release site, species, run, and rearing type. As with the observation data, commas,
quotes, headers, and poorly formated lines will be ignored.
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-- begin sample --

3D9.1BF0DB31C5 ,1999-10-23 18:00:00,REDTRP ,1 ,1 ,W

3D9.1BF0DB31DA ,1998-10-25 14:30:00,FISTRP ,1 ,1 ,W

3D9.1BF0DB31E6 ,1998-10-21 13:00:00,FISTRP ,1 ,1 ,W

3D9.1BF0DB31FE ,1998-11-08 14:00:00,FISTRP ,1 ,1 ,W

3D9.1BF0DB3207 ,1998-10-21 13:00:00,FISTRP ,1 ,1 ,W

3D9.1BF0DB321A ,1998-10-15 15:00:00,FISTRP ,1 ,1 ,W

3D9.1BF0DB3225 ,1998-11-10 13:00:00,FISTRP ,1 ,1 ,W

3D9.1BF0DB3226 ,1998-09-24 15:00:00,FISTRP ,1 ,1 ,W

3D9.1BF0DB3235 ,1998-10-15 15:00:00,FISTRP ,1 ,1 ,W

3D9.1BF0DB3252 ,1999-10-30 17:15:00,CROTRP ,1 ,1 ,W

-- end sample --

Optionally, individual covariate data may be input via the tag file. Any
columns in addition to the required ones shown above are taken to be covariate
data. In the example below, length and weight have been added to the end of the
each row. Any number of additional columns can be added so that there is no limit
to the number of individual covariates that can be provided this way. These
covariate data will be available for inclusion in the SURPH data file.

-- begin sample --

3D9.1BF0DB31C5 ,1999-10-23 18:00:00,REDTRP ,1 ,1 ,W ,73 ,2.6

3D9.1BF0DB31DA ,1998-10-25 14:30:00,FISTRP ,1 ,1 ,W ,83 ,4.5

3D9.1BF0DB31E6 ,1998-10-21 13:00:00,FISTRP ,1 ,1 ,W ,91 ,3.2

-- end sample --

5.3 Recapture File

Recapture data are used to augment interrogation data. When a fish is
recaptured, PitPro flags the fish as removed at the recapture site, if the recapture
site is a defined capture history site or the nearest prior-defined capture history site.
In other words, a fish recaptured at McNary Dam, assuming that McNary Dam is
one of the defined capture history sites, is flagged as removed at McNary. If the fish
is recaptured downstream of McNary, but upstream of the next capture history site,
it also will be flagged as removed at McNary.

In some cases fish are recaptured soon after release, and the recapture site
matches the release site. It is possible to configure PitPro to ignore these
recaptures, allowing subsequent observations to be recorded in the capture history
as if the recapture never happened. Downstream recaptures will be treated, as
described above. See Section 4.7.3, “Ignore recaptures at the release site” for more
information on this setting.
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-- begin sample --

3D9.1BF0DE1EE0 ,8/10/2000 17:00,JOHTRP,522.303.215.060.024.007

3D9.1BF0DE20E3 ,8/11/2000 18:30,JOHTRP,522.303.215.060.024.007

3D9.1BF0DE25A2 ,8/5/2000 19:42,JOHTRP,522.303.215.060.024.007

3D9.1BF0DE2F1F ,8/11/2000 18:30,JOHTRP,522.303.215.060.024.007

3D9.1BF0DE3F46 ,8/11/2000 18:30,JOHTRP,522.303.215.060.024.007

3D9.1BF0DE4FC4 ,8/4/2000 18:23,JOHTRP,522.303.215.060.024.007

3D9.1BF0DE5207 ,7/16/2003 0:00,JOHNSC,522.303.215.060.024.009

3D9.1BF0DE5797 ,4/15/2000 17:47,JOHTRP,522.303.215.060.024.007

3D9.1BF0DE59B0 ,9/4/2002 0:00,JOHNSC,522.303.215.060.024

3D9.1BF0DE5A7B ,9/4/2002 0:00,JOHNSC,522.303.215.060.024

3D9.1BF0DE5DDD ,7/27/2000 17:30,JOHTRP,522.303.215.060.024.007

-- end sample --

5.4 Mortality File

Mortalities are treated the same way as recaptures except that removal of
mortalities is never optional. See Section 5.3 (“Recapture File”).

-- begin sample --

3D9.1748CE3AC8 ,2000-06-15 09:57:00,SNAKER,522.352

3D9.1748CE3AC8 ,2000-06-08 09:29:00,SNAKER,522.352

3D9.1748CE3B0B ,2000-06-01 09:02:00,SNAKER,522.352

3D9.1748CE3B0B ,2000-06-08 09:29:00,SNAKER,522.352

3D9.1748CE3B2C ,2000-05-25 07:32:00,SNAKER,522.352

3D9.1748CE3B70 ,2000-05-25 07:32:00,SNAKER,522.352

3D9.1748CE3BCC ,2000-04-30 11:12:00,YANKWF,522.303.591.011

3D9.1748CE3BF6 ,2000-06-13 11:15:00,SNAKER,522.227

3D9.1748CE3C2D ,2000-06-08 09:29:00,SNAKER,522.352

3D9.1748CE3C8A ,2000-04-30 11:12:00,YANKWF,522.303.591.011

3D9.1748CE3CA2 ,2000-05-07 12:36:00,YANKWF,522.303.591.011

-- end sample --
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6.0 Output Files

6.1 Capture Histories File

The Capture histories file is either a SURPH-compatible file (Version 1 or
2), or a ROSTER-compatible file.

6.2 Errors File

The Errors file has one line for each removed fish, followed by a series of
fields representing the particular errors that contain either a “1”, indicating an
error, or a “0”, indicating no error. The errors are labeled in the Table 6.1.

-- begin sample --

3D9.1BF0E7C0C2 0 0 0 0 0 0 0 0 1 0 0 0 0

3D9.1BF0E87367 0 0 0 0 0 0 0 1 0 0 0 0 0

3D9.1BF0E89EAF 0 0 0 0 0 0 0 1 0 0 0 0 0

3D9.1BF0E998A3 0 0 0 0 0 0 0 0 1 0 0 0 0

3D9.1BF0EE778A 0 0 0 0 0 0 0 1 0 0 0 0 0

3D9.1BF0EF5375 0 1 0 0 0 0 0 0 0 0 0 0 0

3D9.1BF0EF668E 0 0 0 0 0 0 0 1 0 0 0 0 0

3D9.1BF0F5F9F1 0 0 0 0 0 0 0 1 0 0 0 0 0

-- end sample --

6.3 Travel Time File

The Travel time file provides the first and last travel times to each
observation site for each fish. Travel times are only calculated if a release date is
provided for the fish in the release data file. The file has a header indicating the
column labels: the first column is be the PIT-code, the remaining columns are pairs
of first and last detections for each defined site as defined on the Sites tab
(Section 4.3). If a fish was not detected at a site, the travel times will be reported as
0.000. If a fish was detected at a given site but no release data was provided for the
fish, the travel times will be reported as -999.999.
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Table 6.1: Error file fields.

Column Description
1 Observation on known juvenile detector outside of migration year.
2 Fish detected as jack.
3 No release data are found.
4 Site-released fish not in river.
5 PIT tag not found in list of valid tags.
6 Observations are out of sequence.
7 Fish observed before release date.
8 Fish removed before first capture history site.
9 Fish observed in year following migration year before cutoff.
10 Stage unknown.
11 Wrong species.
12 Wrong run.
13 Wrong rearing type.
14 Fish has zero length.

-- begin sample --

pitcode mc mc jd jd bv bv

3D9.1BF0E70BE7 61.490 61.491 0.000 0.000 66.671 66.671

3D9.1BF0E70D00 62.555 62.556 0.000 0.000 0.000 0.000

3D9.1BF0E70D62 0.000 0.000 0.000 0.000 0.000 0.000

3D9.1BF0E70F51 57.844 57.844 0.000 0.000 0.000 0.000

-- end sample --

6.4 Detection Date File

The Detection date file is similar to the travel time file except that it
records the first and last date of observation at each detection site. It has an
additional column for release date, so it is possible to calculate travel times to all
sites, and between all sites, using only this file. This is the file that the Results
Manager uses to create the travel time table.

The date format is “Julian” date, which encodes year information, making it
possible to calculate travel times across years, which is essential when processing
fish with adult observation data. In prior versions of the program, what was called
Julian date was actually something slightly different, which worked fine for internal
calculations, but did not work well when exporting data to external programs, like
Excel. This has been updated to use actual Julian dates and should now be
consistent with the general usage of the term.
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-- begin sample --

pitcode rel mc mc jd jd bv bv

3D9.1BF0E70BE7 2451620.500 2451682.490 2451682.491 0.000 0.000 2451687.671 2451687.671

3D9.1BF0E70D00 2451620.500 2451683.555 2451683.556 0.000 0.000 0.000 0.000

3D9.1BF0E70D62 2451620.500 0.000 0.000 0.000 0.000 0.000 0.000

3D9.1BF0E70F51 2451620.500 2451678.844 2451678.844 0.000 0.000 0.000 0.000

-- end sample --

6.5 Sequence File

The Sequence file provides detailed information on observation sequence
analysis. There are five steps reported in the sequence file: the raw observation
sequence, the sequence sorted by time, the sequence compressed, the sequence
transformed for fallback, and the sequence fit into the structure defined by the
selected capture history sites.

The fields in the sequence each contain a three-part item, separated by
periods (“.”); the location, the life stage, and the outcome. For instance, “gr.J.U”
indicates an observation at Lower Granite Dam of a juvenile fish which had an
unknown disposition at that point in the observation sequence. The life stage can
be “U” for unknown, “J” for juvenile, or “A” for adult. The outcome can be “R”
for returned to river, “T” for transported, “S” for sampled, “B” for bypassed, “H”
for held, or “U” for unknown.

In the sample code shown below, fish 3D9.1BF0E70A5E is observed at Lower
Granite Dam 4 times and Rapid River Hatchery Pond 3 times as shown in the first
line, prefaced by “r” for “raw.” The number “1” following the “r” indicates that the
sequence is out of order with respect to location. In the second line, the sequence is
sorted with respect to time, and now the out-of-sequence indicator is set to “0”, or
false. In the third line, prefaced with “c” for compressed, the multiple observations
at each site are compressed into one, with the life stage and outcome combined to
result in an overall stage and outcome determination. In the final line, if a fallback
occurred, the sequence is transformed to account for the fallback. See the section in
Stage Settings tab of the configuration (Section ??). The last line is the result
after fitting the observation sequence to the selected capture history fields, where
observations at sites not in the capture history fields are ignored, capture history
sites with no valid observations are assigned a no-detection observation record, and
observations at valid sites are shown in the correct position in the capture history.
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-- begin sample --

r 1 3D9.1BF0E70A5E gr.J.U gr.J.T gr.J.T gr.J.T rp.U.R rp.U.R rp.U.R

s 0 3D9.1BF0E70A5E rp.J.R rp.J.R rp.J.R gr.J.U gr.J.T gr.J.T gr.J.T

c 0 3D9.1BF0E70A5E rp.J.R gr.J.T

t 0 3D9.1BF0E70A5E rp.J.R gr.J.T

m 0 3D9.1BF0E70A53 gr.J.T go.J.N lm.J.N mc.J.N jd.J.N bv.J.N

-- end sample --
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7.0 Results Manager

The Results Manager provides high-level data summaries and tools for
analyzing the program output. The Results Manager searches for output in the
output folder, defined on the Files configuration tab (Section 4.2), and presents a
menu display with the population names of any results data found there. Selecting a
prefix loads the associated data into the Results Manager.

7.1 Summary

The Summary tab provides an overview of all output files for the selected
prefix, giving the names and sizes of each file. By clicking on the file name, the user
can view the contents of a file. To return to the summary, click the Back button.

7.2 Data

Here the program lists, and provides access to, the data input files that were
selected as the data input for the given run.

7.3 Errors

The Errors tab provides a summary of any errors encountered. The table
lists each possible error and the number of fish for which the error occurred. The
total number of errors is provided at the bottom of the table. This table lists the
errors in the same order as they appear in the error file.

7.4 Travel Time

The Travel Time tab provides arithmetic means, corresponding standard
errors, and population sizes for all possible reaches encountered by the study fish.
These calculations are based on the detection date file and will only be available if
that data output file has been generated. If this tab is blank, confirm the check box
beside Detection date under the Output file switches and suffixes heading on
the File configuration tab has been checked (see Section 4.2.2).
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Figure 7.1: Results Manager - Summary.
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Figure 7.2: Results Manager - Data.
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Figure 7.3: Results Manager - Errors.
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Figure 7.4: Results Manager - Travel Time.

Travel times to adult sites will be incorrect unless the detection date format
has been set to Julian date. This can be set on the File configuration tab under the
section heading Detection date file (4.2).

7.5 Cormack-Jolly-Seber

PitPro provides Cormack-Jolly-Seber estimates for SURPH2 data output.
These estimates are not valid for any results that include adult observations, except
when the adult observations occur in the last field only. There are two settings
which influence the format of the output.
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Figure 7.5: Results Manager - Cormack-Jolly-Seber.
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Figure 7.6: Results Manager - PIT-Tag Tracker.

7.6 PIT-Tag Tracker

The PIT-Tag Tracker allows the user to view all input and output data
pertaining to an individual fish in one convenient place. This can be useful for
tracking down issues that may arise in data processing. To view the data, enter a
PIT code and click on the Go button. The default view is a summary table of the
capture history output and a table with input date for the fish. Check Show
details for a full report displaying data from the observation and tag input files, and
the capture history, errors, travel time, detection date, and sequence output files.
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7.7 Data Menu

Several of the result reports are available for export to comma separated
variable (CSV) format. These can be accessed via the Data menu of the Result
Manager. These reports include the Cormack-Jolly-Seber (CJS) report and the
travel time report. In addition, the covariance matrix from the CJS calculation is
also available from this menu, in CSV format.
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8.0 Update Manager

The Update Manager is a new feature of PitPro that facilitates keeping
the program and sites configuration up to date (Figure 8.1). If the computer
running PitPro is connected to the internet, PitPro will check the Columbia Basin
Research (CBR) server for new versions of program software, and if a more recent
version is available, will notify the user. The notification is in the form of a green
check mark icon that appears in the program toolbar when an update is available
for download. By clicking on the check mark icon, or by selecting Help->Update
Manager, the Update Manager window will pop up and provide a quick
reference for current versions vs. available version. If a newer versions of the PitPro
program or of the sites configuration file are available, the user simply checks the
Update check box next to the appropriate item (if it’s not already checked), and
then clicks the Update button. The Update Manager will automatically replace
the default sites configuration file with the latest version and download the latest
PitPro program distribution. To install the new version of PitPro the user can
unpack the distribution and run the installation program found in the archive.
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Figure 8.1: Update Manager - Track latest versions.
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9.0 PitPro Decision Logic

PitPro is a tool to convert raw PIT-tag data from the PTAGIS database into
a format that is more easily analyzed by software provided by Columbia Basin
Research. Multiple PIT-tag observations occur for a single fish at a single detection
site (i.e., a dam), representing one particular route out of many possible routes a
fish may take. Though most of these routes result in fixed outcomes (e.g., returned
back to the river, bypassed), some are dependent on specific activities occurring
during intermittent periods at the detection site, such as transportation or sampling.
As such, there are several decisions required in determining an individual’s fate and
the appropriateness of using the resulting detection or capture history in an
analysis. Listed below is the general logic behind the processing of the PIT-tag
detections of each fish. These approaches are crucial to the proper interpretation of
any analysis results. Researchers using this software are encouraged to be aware of
these general assumptions, to better understand the applicability of their results.
Specific logic criteria for each detection site can be viewed and altered using Show
site configuration under the Data menu in PitPro.

• At an observation site, a fish will be assigned one of three outcomes: returned
to river, censored, or transported. For a censored fish, observations up to that
point are used, but subsequent observations are ignored.

• A monitor is a series of PIT-tag coils at an observation site. Monitors have
one of five designations: return to river, hold, sample, transport, or unknown.

• All observations at a detection site are used to determine final outcome at
that site. Two methods of processing those observations are available as a user
option:

– Use only the last observation in determining outcome (Table 9.1).

– Give priority to censored outcomes, regardless of subsequent detections
(Table 9.2).

Table 9.1: Outcome determination - last detection method.

Last Detection Monitor Outcome
Return to river Returned to river
Transport Transported
All others Censored
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Table 9.2: Outcome determination - removal trumps all method.

Detection Monitor Outcome
Sample Censored
Hold Censored
Return to river; no sample or hold Returned to river
Transport; no sample, hold, or return to river Transported
Unknown; no other monitor to imply specific outcome Censored

• A transported fish is not observed again as a juvenile, unless the observation is
at the Towed Estuary Array (TWX). Any fish observed as a juvenile
subsequent to transportation at a previous site is censored at the transport
site. A transported fish can be observed as an adult.

• An adult observation is given an ocean age class based on the number of
winters between the juvenile outmigration and the adult observation. For
example, if 3 winters have passed, the ocean age class is 3, which is
represented by the letter “C”.

• A minijack is defined as a fish that migrates upstream during its juvenile
outmigration year. A user must specify a cutoff date that divides the juvenile
outmigration from the adult returning migration. Minijacks are assigned to
ocean age class 1 (“A”) or are removed as errors, at the option of the user.

• A recaptured fish is given an outcome of censored. The location of the
outcome is based on the user-selected set of capture history fields. If the
recapture site coincides with one of the capture history fields, the censored
outcome applies to that site. If the recapture does not coincide with any
defined capture history field, but is downstream of at least one capture history
field, the censored outcome applies to the nearest prior field in sequence. If
the recapture occurs in sequence before any capture history field, the fish is
removed from the release group and will not be included in the program
output. For instance, if the first defined capture history field is McNary Dam,
but the recapture occurs at Rock Island Dam, the fish will be removed.

• When a recapture sites that are not a specific location but instead span a
range of locations the following policy is used. If the fish is observed at other
sites the sequence of observations is used to locate the recapture. If the
recapture is the only observation of the fish, the up-river extent of the range is
used for juvenile outmigration, and the down-river extent of the range is used
for adult migration.

• A mortality is treated in the same was as a recapture. See above.
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• Certain mortalities are considered to be due to natural causes. Unlike
handling mortalities which, if left in, would bias the survival estimates, these
mortalities occur during the natural course of events, and so are not removed
from the analysis. As with any other natural mortality, the fish will simply
not be observed again. Here is a list of the mortality sites that PitPro treats
as naturally occurring mortalities:

– 3MILIS (Three Mile Canyon Island)

– BADGEI (Badger Island)

– CRESIS (Crescent Island)

– ESANIS (East Sand Island)

– FOUNDI (Foundation Island)

– IS18 (Island 18)

– LMEMIS (Little Memaloose Island)

– LMILIS (Little Miller Island)

– RICEIS (Rock Island)

– RICHIS (Richland Island)

• Adult fallbacks are handled in one of two ways by user option:

– The final route through the system is used for capture history analysis
and any migration prior to a fallback is ignored. For instance, if an
returning adult is observed at a site, falls back to downstream of the site,
and is not observed on a subsequent ascent of the site, the relevant field
in the capture history will be not-detected.

– Any observation at a capture history field is included. Whether the
observation occurred prior or subsequent to a fallback is not an issue.

• A fish observed anywhere before its release date is removed.

• In cases where the river kilometer (km) for a recapture or mortality is
un-available, the program will look up the pre-defined location for the site.
When this site represents a range of river kms, the following policy is followed.
If the release site is subsequent in sequence to a site with a known river km,
the recapture applies to that site. If there are no such preceding sites, the
upstream river km is used for a juvenile-stage observations; the downstream
site is used for the adult-stage observation. It is best to include river km data
in your PTAGIS queries for recapture and mortality data files. These are more
specific and avoid this issue.
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10.0 Site Configuration

The internal site configuration is based closely on the PTAGIS site
configuration available from the PSMFC web server:

ftp://ftp.ptagis.org/Reports/TMT/site_con_spec.out

This file is checked weekly for updates and any new or changed configuration
data are automatically added to PitPro. The latest configuration updates can be
added to your current version of the program through the Update Manager (see
Section 8).

It is possible to access this internal configuration and to make changes to it,
thereby changing the default program behavior. This can be useful in cases where
the user has more specific knowledge about a certain interrogation site or in cases
where the user needs to add an interrogation site that does not exist in the PTAGIS
configuration. One way to modify the site configuration is to save a copy of the
internal site configuration, modify this file, and re-load the configuration into the
program.

To view and save the internal configuration, first select Data->Show sites
configuration from the program menu to display the configuration file. The file
will be displayed in a text window in plain text format. From the menu of the text
window, select File->Save as. Next, make any modifications, as described below,
by using an external text editor, i.e., Notepad or Wordpad. Next go to the advanced
configuration tab, un-check Use built in sites configuration and select the saved
configuration file. Finally, click the Refresh button apply the changes. Now the
program will use your customized sites configuration.

10.1 Modifying the Sites Configuration

The PitPro sites configuration is structured with three basic types of data:
site codes, observation sites, and release sites. The site codes correspond to the
PTAGIS site codes and represent particular interrogation sites: GRJ, MCJ, BO4,
etc. An observation site is defined to be a collection of one or more of these site
codes. For instance, Lower Granite Dam encompasses the GRJ, GRX, and GRA
site codes as part of its definition. These site code and observation site definitions
provide the data required by PitPro to determine fish outcome, etc. The mortality
and recapture data use the release site codes for their location codes. The release
site data in the site configuration file allow PitPro to determine the river km for
each mortality and recapture site.
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10.1.1 Site Code Definition

A site code is the three-letter code that represents a grouping of monitors. In
the PTAGIS site configuration data, the monitor groupings and names for a given
site code are grouped into time periods; when new systems are added or old system
removed, a new section is added in the site configuration for the site code. The
PitPro site code configuration is structured in a way similar to the PTAGIS site
configuration (Figure ??).

Within one site code configuration can be one or more date ranges and any
number of exceptional cases, which override the standard configuration during a
given time period. Within a date range is a series of monitor configurations giving
the outcome, coils, life stages, and ascent order (for adult ladders) associated with
the monitor. Each exceptional case gives the same information as well as a date
range, but takes precedence over the standard site code configuration for the time
period. These are configurations that deviate from the PTAGIS site configuration
and have been added to the PitPro configuration over the years, as these
exceptional cases become known.

When processing data, PitPro looks for a match of the observed site code
(e.g., GRJ), then the correct configuration range based on the observation date,
finds the coil within the date range configuration, and then returns the relevant
information, especially disposition and life stage. When assigning the disposition to
a capture history field, the program matches the disposition to the capture history
field by use of the observation site configurations (Section ??).

10.1.1.1 Range

A range definition defines a date range for which the enclosed configuration
applies. The date range is defined within a site code configuration. The date range
encloses a series of definitions, each pertaining to a particular monitor, each
consisting of one line, with each field separated by a colon (“:”). The first field is
the indicated disposition; “U”, “R”, “B”, “S”, “T”, or “H” meaning unknown,
returned to river, bypasses, sampled, transported, or held, respectively. Depending
on how the program is configured, this disposition can stand alone (i.e., be the final
determination of disposition), or be combined with other observations to determine
the final disposition for the given site.

The second field indicates the life stage of fish that can be detected on this
monitor, where “A” indicates an adult monitor; “J”, a juvenile monitor; and “U”,
unknown. The third field provides an ordering to the monitor, which is only used
for adult ladders and fallback calculations, and does not come into play in PitPro.
The fourth field is the monitor name, and the final field gives a listing of the coils
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for the monitor. For historical reasons, PitPro has always used the coils instead of
the monitor names in the observation data file; coil names and monitor names are
basically synonyms, however (when looking at one site code and a specific date
range).

10.1.1.2 Exception

An exceptional case occurs when actual site configuration is found to differ
from the standard site configuration as defined by PTAGIS. These exceptional cases
have been discovered over the years and appended to the PitPro configuration.
These are listed at the end of the configuration for a given site code but take
precedence over the normal configuration.

The format consists of a begin date for the exception, an end date, and a
monitor definition, enclosed in braces. For instance, based on the definition in
Figure ??, an observation at GRJ on May 16, 2001 on the RACEWAY EAST
monitor (coil 11, 12, or 13) would be flagged with a disposition of “R” (returned to
river), instead “T”, as indicated by the standard configuration.

10.1.2 Observation Site Definition

An observation site is a grouping of site codes. For instance, Lower Granite
Dam has over the years used three site codes (what PTAGIS calls sites): GRJ,
GRX, and GRA. PitPro uses these codes for matching observations by site code to
the correct field in the capture history. A field is a one-to-one match with an
observation site, as defined here.

The observation site definition also provides the river km of the site for use
in ordering the capture history fields. The life stages that can be observed at the
site are given. For instance, as indicated in Figure ??, both juvenile and adult
observations are possible at Lower Granite Dam. The type of site is defined as one
of: dam, trap, or acclimation. These are used in filtering sites for output, but are
not used by PitPro since the sites are explicitly indicated in the configuration
(PitPro shares the configuration with other programs). Text labels are also defined
here. By changing these labels, the output can be customized to a small degree.
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Figure 10.1: Site configuration - site code. Defines a site code, closely mirroring the
PTAGIS site configuration, with augmented configuration for non-standard cases.

code: GRJ

{

range: 03-Jan-00 Present

{

U: J : 0 : A-SEPARATOR GATE : A1 A2

U: J : 0 : B-SEPARATOR GATE : B1 B2

U: J : 0 : DIVERSION / SbyC GATE : C1 C2 C3 C4

R: J : 0 : DIVERSION RIVER EXIT : 91 92 93

U: J : 0 : SbyC GATE : D1 D2 D3

T: J : 0 : RACEWAY WEST / RIVER EXIT : 21 22 23

T: J : 0 : RACEWAY EAST : 11 12 13

S: J : 0 : SAMPLE TANK : 51 52 53

}

range: 01-Jan-94 20-Jan-00

{

U: J : 0 : A-SEPARATOR GATE : 28 2A

U: J : 0 : B-SEPARATOR GATE : 2C 2E

T: J : 0 : RACEWAY EAST : 10 12 14 16

T: J : 0 : RACEWAY WEST/EXIT : 18 1A 1C 1E

U: J : 0 : DIVERSION 1 : 36 38 3A

U: J : 0 : DIVERSION 2 : 30 32 34

S: J : 0 : SUBSAMPLE : 20 22 24 26

}

range: 25-Mar-88 01-Jan-94

{

U: J : 0 : A-SEPARATOR GATE : 28 2A

U: J : 0 : B-SEPARATOR GATE : 2C 2E

T: J : 0 : RACEWAY EAST : 10 12 14 16

T: J : 0 : RACEWAY WEST/EXIT : 18 1A 1C 1E

R: J : 0 : DIVERSION 1 : 36 38 3A

R: J : 0 : DIVERSION 2 : 30 32 34

S: J : 0 : SUBSAMPLE : 20 22 24 26

}

exception: 15-May-01+08:57:29 18-May-01+04:59:49 { R: J : 0 : RACEWAY EAST : 11 12 13 }

exception: 15-May-01+08:57:29 18-May-01+04:59:49 { R: J : 0 : RACEWAY WEST / RIVER EXIT : 21 22 23 }

exception: 01-Jan-94+00:00:00 01-Apr-95+00:00:00 { R: J : 0 : DIVERSION 1 : 36 38 3A }

exception: 01-Jan-94+00:00:00 01-Apr-95+00:00:00 { R: J : 0 : DIVERSION 2 : 30 32 34 }

}
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Figure 10.2: Site configuration - observation site. Defines a grouping of site codes,
along with site-specific information, useful for sorting and stage determination.

site: gr

{

name: Lower Granite Dam

shortName: LGR

riverk: 522.173

type: dam

stage: juvenile adult

codes: GRJ GRX GRA

}
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11.0 PTAGIS

PIT-tag data is available from the PIT Tag Information System (PTAGIS) of
the Pacific States Marine Fisheries Commission (PSMFC). To access the PTAGIS
database and download data you will need to create an account. The information
about PTAGIS found in this document is valid at the time of publication (12/6) but
is subject to change.

Instructions for creating an account and running queries can be found at:

http://www.ptagis.org/ptagis/

Generally the process is as follows: select a data source, select the fields for
your query, select a filter for the query that restricts the output to a particular set
of values, select sorting, choose any desired summaries, choose what type of headers
or footers are desired, and finally, give the “query” a name and save it. Once a
query has been saved, it can be “run,” and upon completion of the run, the data
will be available for download.

For PitPro, it is important to select the correct fields in the correct order.
Screen shots of the PTAGIS field definition page for each of the data input types, or
data sources, are provided in this document. The four data sources used by PitPro
are tagging data (11.1), interrogation data (11.2), recapture data (11.4), and
mortality data (11.5).

It is also necessary to sort the interrogation by “Tag id,” but no further
sorting is required for the interrogation data, nor the other data types. No headers,
footers, or data summaries should be selected.

Once the query is run, the data will be available for download. Data
downloaded from PTAGIS is in a format compatible with PitPro, and no additional
processing should be required. It is only necessary to rename the files, giving them
the suffix that PitPro expects for each particular data type. See Table 4.1 for the
appropriate suffixes. If the data is to be processed by a relational database, i.e.,
Access, or a spreadsheet, i.e., Excel, care must be taken to preserve the correct field
order and format.
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Figure 11.1: PTAGIS - Tagging file format.
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Figure 11.2: PTAGIS - Interrogation file format.
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Figure 11.3: PTAGIS - Interrogation file format.
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Figure 11.4: PTAGIS - Recapture file format.
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Figure 11.5: PTAGIS - Mortality file format.
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